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File menu commands
The File menu offers the following commands:

New Index Creates a new index.
Open Index Opens an existing index.
Save Index Saves the current index in its original file.
Save Index 
As

Saves the current index to a specified file name.

Print Prints the document being viewed.
Print Setup Selects a printer and printer connection.
Edit Edit the selected file with the default text editor
Launch Open the selected file in its associated application
Preferences Set the default editor and zip file temporary directory
1,2,3,4 Open previous index files
Exit Exits Wilbur.



Edit menu commands
The Edit menu offers the following commands:

Copy Copies data from the document to the clipboard.



Search menu commands
The search menu offers the following commands:

Find Search the index for a word or words.
Find Next Look for the next occurrence of the search words
Find Previous Look for the previous (closer to top) occurrence of the 

search words
Quick Find Search for the word under the cursor in the contents 

pane

View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
     Status 
Bar

Shows or hides the status bar.

Font Change the font of the file list or file contents pane.
Internation
al 
Characters

Toggles the viewing of international characters in the 
contents pane.

QuickView Launches Quickview for the currently selected file
Automatic 
Quickview

Launches Quickview for each new file selected and then 
regains control

Next File Select the next file in the file list
Previous 
File

Select the previous file in the file list

Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number Wilbur.



New command (File menu)
Use this command to create a new index. Since no files will have been selected for the new 
index, the Index Dialog will be opened so you can define the files to include.

You can open an existing index with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open a previously saved index.    When you start Wilbur, it 
automatically opens the last index you were working with.

You can create a new index with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    Under Win NT this box lists files with the 
extension you select in the List Files of Type box.      Win95 lists the files in a separate box.

List Files of Type
Select the type of file you want to open:
Wilbur indexes normally have a file extension of Wilbur.

Win NT
Drives

Select the drive in which Wilbur stored the file that you want to open. 
Directories

Select the directory in which Wilbur stored the file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 

Win95
Look In:

Use this box and the buttons beside it to control which computer and directory to look
in. You can click on the ? on the title bar and then point to elements on the dialog for 
more information.



Save command (File menu)
Use this command to save the current index to its current name and directory.    When you 
save an index for the first time, Wilbur displays the Save As dialog box so you can name 
your index.    If you want to change the name and directory of an existing index before you 
save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the current index so you can use it in the future 
without rebuilding it.    Wilbur displays the Save As dialog box so you can name your index.    

To save an index with its existing name and directory, use the Save command.



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save an index with a different name.    Wilbur adds the extension 
you specify in the Save File As Type box.

Win NT
Drives

Select the drive in which you want to store the index.
Directories

Select the directory in which you want to store the index.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 

Win95
Look In:

Use this box and the buttons beside it to control which computer and directory to look
in. You can click on the ? on the title bar and then point to elements on the dialog for 
more information.



File Preferences

This command opens the Preferences Dialog where you can specify a command for the text 
editor (the default is notepad.exe) and the directory to used for temporary storage when 
unzipping files.    You can also set the separation allowed in words in a near search (see 
Index/Search).



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
indicies you closed.    Choose the number that corresponds with the index you want to open.



Exit command (File menu)
Use this command to end your Wilbur session.    You can also use the Close command on the 
application Control menu.    Wilbur prompts you to save an index that has been built or 
updated with out saving.

Shortcuts
Mouse: Double-click the application's Control menu button.

 (Win95 will have a small Wilbur icon instead of the Control menu. You can double 
click on this or just click on the X    at the right of the title bar to shut Wilbur down.)

Keys: ALT+F4



Copy command (Edit menu)
Use this command to copy selected text from the view pane onto the clipboard.    This 
command is unavailable if there is no text currently selected in the view pane.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Wilbur, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to the tools used in Wilbur.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new index.

Open an existing index.    Wilbur displays the Open dialog box, in which you can 
locate and open the desired file.

Save the current index with its current name.    If you have not named the index, 
Wilbur displays the Save As dialog box.

Copy the selection to the clipboard.

Print the contents of the view pane.

Specify the files to include and exclude from the index

Build the index from scratch for the specified files.

Update the index to reflect any changes since the last full build.

Search the index for a word or combination of words.

Repeat the last search, searching forward in the file.

Repeat the last search, searching backwards in the file.

Invoke the default text editor on the selected file.

Change the font in the file list or file content pane.
{bmc hlp\stop.bmp) Halt the current build or update operation.

Show the version number of Wilbur

Context sensitive help.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
The status line is also used to indicate progress while building or updating an index. A check 
mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Wilbur window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

When a file is selected, the status line shows information about the file such as its size, 
when it was last modified, its attributes and what number it is out of how many in the whole 
list.

While building or updating an index, the status line shows the current group of files being 
processed.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Wilbur and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of 
Wilbur.



Context Help command 

Use the Context Help command to obtain help on some portion of    Wilbur.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Wilbur window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
(Wilbur) and the name of the current index and various window control buttons.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

The title bar contains the following elements:
Application Control-menu button
Maximize button
Minimize button
Name of the application (Wilbur)
Name of the current index
Restore button



Scroll bars
Displayed at the right and bottom edges of both the file list and file view panes.    The scroll 
boxes inside the scroll bars indicate your vertical and horizontal location in the list or file.    
You can use the mouse to scroll to other parts of the list or file.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (System menu)
Use this command to display a four-headed arrow so you can move the Wilbur window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



Minimize command (System menu)
Use this command to reduce Wilburs window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)
Use this command to enlarge Wilburs window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (System menus)
Use this command to shut down Wilbur or a dialog box.

 Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the Wilbur window or dialog box



Restore command (System menu)
Use this command to return Wilburs window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying the Document
<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.





Print command (File menu)

Use this command to print a document.      The file selected in the file list is printed by the 
application associated with its extension.    If the file does not have an application associated
with it, then this command has no effect. Note that the entire document is printed.    If you 
wish to only print some pages, use the file launch command to start the application and 
select the items to be printed.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Wilbur's Mission

Wilburs mission is to help you find things in all those files you accumulate on your hard disk.
He does this by creating an index of all the words in a given set of files that you define,    For 
instance you might want an index of all the *.txt, *.doc and *.wri files on your C drive.    Once
the index is prepared, Wilbur can quickly show you a list of all the files containing any word 
or group of words. He can also show you a view of the sought after words in context in any 
file selected.
In addition to simple word searches, Wilbur allows word descriptions to contain wild cards 
and simple logical expressions.    Wilbur can even index the files inside Zip archives on your 
disk.
You can also configure most word processors and program development environments with 
hot keys that automatically start a Wilbur search for the word under the cursor. 

Please note that Wilbur is a Win32 program and will only run on the Intel version of WinNT 
(3.5 or higher) and Win95.    It will not run with the Win32s extensions for the 16 bit 
Windows.



Wilbur's Display

Wilbur uses a simple two pane window to display his results.    On the top is a list of files that 
meet the current search criteria.    If the search criterion is blank, then this list will contain all
of the files in the index.
When a file is selected from the file list, then a text representation of this file is shown in the 
file contents pane on the bottom, with the first occurrence of a search word being 
highlighted.    Wilbur does not attempt to do anything beyond basic formatting of this text, 
but double clicking on the file name in the list will launch the file in its associated 
application.
You can change the amount of area assigned to each pane by using your mouse to point at 
the divider between the two panes, and then pressing and holding the left mouse button 
while dragging the divider to the desired position.

At the top of the screen Wilbur has a standard Windows menu bar.
The File menu used to save and recall different indices.
The Edit menu  is used to copy text from the view pane to the clipboard
The Index menu is used to maintain an index.
The Search menu is used to search for words in the index
The View menu is used to toggle the Tool Bar and the Status Bar on and off and change
the fonts used in the file list and file contents pane.



Getting Started

When you run Wilbur for the first time or create a new index with the File/New command, 
Wilbur will display the Index Dialog where you can specify which files are to be included in 
the index.    When you have done this press the Build button on the dialog or the Index/Build 
command after closing the dialog. This will cause Wilbur to scan all of the included files and 
prepare an index that can be used for quickly finding words you are looking for.
When the index is built, you can save it with the File/Save command so it can be used in 
future sessions. You can now search for words with the Search/Find command.
As you use your computer to create, delete and modify files your index will get out of date. 
You can rebuild the index from time to time or just update it with the Index/Update command
which is somewhat faster.



Contacting RedTree

If you have any questions, suggestions, or need any help, please contact us at one of the 
following:

Internet EMail: wilbur@redtree.com
WWW: www.redtree.com
CompuServe: 70233,1004
Fax: +1-604-423-6519
Postal: 2 Timberline Crescent

Fernie, B.C., V0B 1M1
Canada

Unfortunately we are not able to offer telephone support at this time.



Index Menu Commands
The Index menu offers the following commands:

Edit Open the index dialog where you can specify which files to include 
and exclude from your index.

Build Scan the files on the disk and prepare the index.
Update Scan the disks for files that have been modified since the index was 

built and updates the index accordingly.
Stop Halts the current build or update operation.

Building an Index

This Index/Build command tells Wilbur to start indexing all the files you have designated in 
the Index/Edit dialog. You must build the index before you can search the files.
Building the index will probably take a few minutes if you have a significant number of files, 
particularly if you have a lot of zip files and are treating them as directories. Of course as 
you work on your computer, you will modify the contents of the indexed files or add files to 
the group and you will need to update the index to reflect these changes.    This is done with 
the Index/Update command. Since this command does not have to look at files that have not
been modified since the full index was built, it is much faster.
While Wilbur is indexing your files, you can still view and launch whatever files are listed in 
the file list, but you cannot do new searches. You can interrupt the indexing by clicking on 
the

button on the toolbar, selecting Index/Stop on the menu bar or by pressing the escape key 
on the keyboard.    If you interrupt the indexing, the resulting index will not have any files 
indexed, but all of your include and exclude specifications will be preserved.    If there was a 
previous version of the index stored, you can read it back in, but you will have to first use 
the File/New command to clear the erased copy from Wilburs memory.

Shortcuts

Toolbar:
Keys: CTRL+B



Updating an Index

You must build an index before you can search your files for whatever words you want. As 
you work with these files, the index will slowly get out of date. Rather than rebuilding the 
entire index, the update command will just re-index new or modified files and thus is quite a 
bit faster than doing a full build.
Because update always checks all files modified since the last full build, you will still want to 
periodically do a full build so that later updates are faster. Also the update process does not 
remove deleted or moved files from the index, so you may encounter a file in the file list that
cannot be read since it is no longer there.
While Wilbur is indexing your files, you can still view and launch whatever files are listed in 
the file list, but you cannot do new searches. You can interrupt the indexing by clicking on 
the

button on the toolbar, selecting Index/Stop on the menu bar or by pressing the escape key 
on the keyboard.    If you interrupt the indexing, the resulting index will not have any files 
indexed, but all of your include and exclude specifications will be preserved.    If there was a 
previous version of the index stored, you can read it back in, but you will have to first use 
the File/New command to clear the erased copy from Wilburs memory.

Shortcuts

Toolbar:
Keys: CTRL+U



Defining the Files to be Indexed
Before you can begin searching for words in your files, you must build an index and before 
you can build an index you must tell Wilbur what files are to be included in the index. The 
Index/Edit command invokes the Index Dialog where you can specify which files to include or
exclude from your index.
Note that you can use many different indexes with Wilbur. For instance I have a text index 
that contains all the files on my disk with letters, email, program documentation, etc.; 
another that indexes my program files; and another that indexes all the sample programs on
my compilers CD-ROM.
You can switch from one index to another with the File menu commands.

Shortcuts

Toolbar:
Keys: CTRL+I



Index Dialog
This dialog is used to tell Wilbur which files you want included and which files you want 
excluded from the index.
The dialog consists of two lists; one for the files to be included and one for those to be 
excluded. Beside each list there are four buttons:

Add Add file names to the list.
Delete Delete the selected file names from the list.
Edit Open a dialog with the selected file name, so it can be edited.
Clear Remove all entries from the list.

It is tempting to just include all the files (*.*) on your disk and then exclude those files you 
dont want indexed like *.exe.    You will probably end up with a huge slow index doing this. 
Instead include those files and file types that you know you want to search through and 
reserve the exclude list for excluding specific subgroups of those files.
Note that if you accidentally clear one of the file lists, closing and reopening this dialog will 
not restore the original names.    Instead exit the dialog and close the index without saving it.
Then read the index back in.    The original lists will have been saved with the index.
Include Numbers
By default Wilbur only indexes words consisting of alphabetic characters and the underscore 
character.    Numbers are considered word separators or terminators like any other non 
alphabetic.    For normal text this is fine, but for programs and some technical material it 
may be useful to include the numbers.    Wilbur has three options for including numbers:

No Numbers - the default
Trailing Numbers - numbers can be anywhere except the first character of the word
All Numbers -    numbers are treated the same as alphabetic characters

Of course including numbers will increase the size of the index somewhat, which is the only 
reason not to always index numbers.
International Characters
When this box is checked, Wilbur will try to include words containing diacritics like ç, ü, æ, å 
etc. Unfortunately most Windows programs store these characters in a different manner 
than other programs do.    Wilbur makes a guess based on the first few characters in the file 
as to the likely format.    This normally works, but is not infallible.    If you are indexing files 
that contain binary material and are not interested in these characters, leaving this box 
blank might reduce the size of your index file.
Treat Zip Files as Directories Check Box
Below the file lists, there is a check box where you can specify that Wilbur is to treat any ZIP 
archive files it comes across as directories.    When selected Wilbur will open zip    files and 
index any files they contain that meet your criteria. When you later perform searches, files 
contained in the ZIP files will be listed and can be viewed like any other file.    The only 
negative is that index building will be somewhat slower.    Updating the index and searching 
will normally not be significantly slower.
Temporary Zip Path    - directory used to temporarily expand zip files



Build or Update
Finally at the bottom of the dialog there are short cut buttons for building and updating the 
index.    They perform the same function as their menu and toolbar counterparts.



Temporary Zip Path

If you are treating ZIP files as directories, you should specify a directory in the Temporary Zip
Path that Wilbur can use to temporarily extract files.    If this directory does not exist, Wilbur 
will create it.    Any files extracted will be deleted when Wilbur is finished with them, but 
directories stored in the ZIP files may be left behind as subdirectories in the temporary 
directory.    These dont take much space, but you can delete them if you wish; Wilbur will 
recreate them when necessary.



Include File Dialog
Enter the name of the file(s) you wish indexed.    The * and ? wild card characters    can be 
used in the filename portion of the path.    All the subdirectories of the path will be searched 
for matching files as well.    For instance c:\word\*.doc would look in the word directory and 
all its subdirectories for files with the doc extension.
You can use a * character for the drive letter to designate that all local non removable drives
should be included.    A + character will include all local non removable files as well as all 
network drives that are assigned to a drive letter.
You can enter multiple paths separated with blanks and they will be entered into the include 
list separately.
The browse button will open up a standard windows file open dialog.    This can be useful for
finding directories etc., but it is designed to select a specific file.    This means you may have 
to pick a typical file and then edit the returned name.    For instance you might pick 
myfile.doc in the c:\word folder and then edit its name to c:\mydir\*.doc.



Exclude File Dialog
Enter the name of the file(s) you wish excluded from the index. The * and ? wild card 
characters    can be used anywhere in the path, including for directories and drives. For 
instance ?:\word\*.dll would exclude any files ending in .dll that was found in the word 
directory of any drive.
You can enter multiple paths separated with blanks and they will be entered into the include 
list separately.
Use this option to refine the selection of files to be indexed.    For instance you might want to 
include all the files that end with the extension SAV, but not want to include the large binary 
files in the UGLYAPP directory that also have that extension. You might then have c:\*.sav in 
your include list and c:\uglyapp\*.sav in your exclude list.
The browse button will open up a standard windows file open dialog.    This can be useful for 
finding directories etc., but since it is designed to select a specific file, you will probably 
have to pick a specific file and then edit the returned text.    For instance you might want to 
change c:\mydir\myfile.doc to c:\mydir\*.doc.



Stopping an Index Build or Update
This command will halt the building or updating of an index.    Inorder to save memory 
usage, the original index is not retained during the build process, so after a build or update 
is interrupted, the resulting index will not have any files indexed. All of your include and 
exclude specifications will be preserved however. If there was a previous version of the index
stored, you can read it back in, but you will have to first use the File/New command to clear 
the erased copy from Wilburs memory.

Shortcuts

Toolbar:
Keys: Esc



Search Dialog
Search For:
Enter the word or words you want to search for. See the Searching For topic for a description 
of using wildcards and logical operators in your search phrase.
In:
Normally you will leave this box empty and Wilbur will search for your words in all the files in
the index.    Sometimes you may want to only search a subset of these files.    In this case 
you can enter a description of the file names you wish to search.    For instance you may 
have indexed all of your txt, wri and doc files, but only be interested in doc files for the 
current search.    By entering *.doc in this box, Wilbur will only display doc files that contain 
your words.    Of course the files must have been in the index when it was last built or 
updated if Wilbur is to find them.    
You can have multiple file descriptions separated by spaces - for instance *.doc *.wri.    You 
can also freely use the ? and * wildcards in the description. Note that the * wildcard will 
match as much as possible of the target name.    The ? always matches a single character.
Reverse Search
Once Wilbur has entered all the files containing your search phrase in the file list, it normally
selects the first file in the list and displays the first occurrence of the phrase in that file in 
the contents pane.    If this box is checked, Wilbur will select the last file in the list and 
display the last occurrence in that file.    When this dialog appears because you have begun 
to type text in the contents pane, the effect of checking this box is to have Wilbur search 
backwards from the current cursor position for the typed text.
Use Soundex:
If this box is checked, Wilbur will not only match the word(s) in your search phrase, but also 
words that sound like them.    This uses the venerable soundex method which is simple, but 
rather general. It can be effective on relative small collections, but tends to generate a lot of
spurious hits in large bodies of text.    This may be removed in future versions, so if you find 
it useful let us know.
OK & Cancel:
Pressing OK starts the search, while clicking the Cancel button aborts the search.



Adding File Names
When adding file names to the index include list, you can use the ? and * wildcards to 
designate groups of files.    Any subdirectories encountered will also be searched, so the 
description:

c:\*.txt
would include all the TXT files on your C drive.    The phrase:

c:\windows\*.ini
would include all the INI files in the windows directory or any of its subdirectories.
The drive designator is not necessary, but probably a good idea.    You can use the * wild 
card as a drive designator to specify all non removable local drives, or + for all non 
removable local drives as well as any network drives assigned a drive letter.
The exclude list also allows wild cards, but handles them somewhat differently.    An 
exclusion must have an appropriate * wild card if it is to exclude files in subdirectories. This 
means that c:\*.exe would exclude all the exe files on your C drive, but c:\?.exe would only 
exclude single character exe files from the root directory of C.    To exclude all single 
character exe files you would need to enter c:\*\?.exe. Note that the * wildcard will match 
everything else in a name unless it is    followed by a ., \, or / character.    The ? always 
matches a single character.
You can enter several file descriptions in the input box as long as they are separated by 
spaces.    They will be added to the list individually.
Also see:
Include File Dialog
Exclude File Dialog



Searching for Words
The Search/Find command will pop up a search dialog where you can enter the phrase or 
phrases you want to find.    Wilbur will then search through its index and list any files 
matching your criteria in the pane on the right.
The search phrase can be a single word or a series or words possibly separated by logical 
operators.    A word can contain a ? to indicate any character is acceptable in that position.    
It can also contain a * to indicate that any number of arbitrary characters can be in that 
position.
If two or more words are listed and they are not separated by a logical operator, Wilbur will 
only list those files that contain all of the words.    In other words, Wilbur will perform a 
logical AND if no other operator is present.    The & character can also be used explicitly if 
you prefer.
You can also use the < symbol to designate that the next word must be present within a 
certain number of words.    All the files which contain both words will still appear in the    file 
list, but Wilbur will only highlight words in the file contents pane, if the second word is near 
the first word.    This means that when you select some files, Wilbur will just jump to the 
bottom of the file since none of the word meet this criteria.    Pressing F3 will continue the 
search in the next file.
The allowable separation for near words can be set in the File/Preferences dialog, or you can 
immediately follow the < symbol with a number which will override this default.    For 
instance:

Santa <20 sleigh
will only highlight occurrences of Santa that are followed within 30 words by sleigh.
If two words are separated by a | symbol, then Wilbur will list any file that has either of the 
words in it.    Here Wilbur is performing a logical OR.
If a word is preceded by the ~ symbol, Wilbur will not list any file which contains that word.
Wilbur evaluates an expression from left to right and does not support parenthesis.    Thus 
the expression:

red    blue | green
would list all files that had both red and blue or green or all three in them.    The expression:

green | red    blue
would find all the files that had green or red and also had blue in them.
Note that Wilbur only indexes words comprised of alphabetic characters or the underscore 
character and optionally numbers.    Only words that are at least three characters long are 
indexed.

Shortcuts

Toolbar:
Keys: CTRL+F or F2



Find Again
The Search/Find Next command looks for the next instance of the sought after text.    The 
search starts from the cursor location in the contents pane and proceeds downwards.    If 
there are no more occurrences of any of the words in the search phrase, Wilbur will proceed 
to the next file in the list.
If you wish to halt a search, simply press any key on the keyboard or click the mouse in 
either pane.

Shortcuts

Toolbar:
Keys: F3



Find Previous
The Search/Find Previous command looks for the previous instance of the sought after text.   
The search starts from the cursor location in the contents pane and proceeds towards the 
beginning of the file.    If there are no more occurrences of any of the words in the search 
phrase, Wilbur will proceed to the previous file in the file list.
If you wish to halt a search, simply press any key on the keyboard or click the mouse in 
either pane.

Shortcuts

Toolbar:
Keys: Shift F3



Quick Find
This command brings up the search dialog with the word that was under the cursor in the 
contents pane already filled in as the search text.    If there was text selected in the contents 
pane, then that is used instead.

Shortcuts
Keys: F4



Text Editting
You can use a default editor to edit any file selected in the file list, by selecting File/Edit.    
This is handy when you want to edit text files that dont have an association with an 
application.    The default editor is Notepad, but you can change this by selecting Preferences
from the file menu.

Files inside ZIP archives cannot be edited.

Shortcuts

Toolbar:
Keys: CTRL+E



Launching a File in an Application
A file in the file list can be launched in its associated application with the File/Launch 
command.    You can also launch a file by double clicking on its name in the file list.    If there 
is no association, then this command will have no effect.
Files inside ZIP archives cannot be launched.

Shortcuts
Keys: CTRL+L or double click name in file list



Preferences Dialog

Text Editor Command
Enter the command to be given when the File/Edit is chosen.    The path name of the file 
selected will be supplied as a parameter to this command.    The browse button opens a 
standard file open dialog to assist you in finding the right path.

Temporary Zip Path
This is the directory where zip files are temporarily expanded.

Max Words Separation for Near
The separation allowed, in words, for a near search (see Index/Search).

Contents Tab Size
The number of character widths (based on the letter A) represented by a tab in the contents 
pane.

Word Wrap Size
The line length in characters before the line is wrapped back to the left edge of the window.



Changing Fonts
You can change the font used in either the file list or file contents pane.    Click in which ever 
pane you want to change and then select View/Font.    A standard font selection box will 
come up allowing you to select the font characteristics you want.
When you save an index, the fonts you have selected will be stored with it and used 
automatically the next time you read in the index.

Shortcuts

Toolbar:



File List Pane
The    top of Wilburs window has a list of the files that meet the current search criteria.    If 
the search criterion is blank, then all the files in the index will be listed.    The listing consists 
of three columns containing the file name, the file extension, the full file path and the date 
the file was last modified.    The file list can be reordered by clicking on the column title bar 
at the top of the list.    To sort by date, just click on the Last Modified header.    If the list was 
already sorted by date, then clicking on it again will reverse the order of the sort (oldest 
first).
Clicking on the name of    a file in the name column will result in the text of that file being 
displayed in the file contents pane at the bottom of the Wilbur window.
Double clicking on a file name will launch that file in its associated application.
If you are running Windows 95, then clicking on the file name with the right mouse button, 
will pop up the context menu for the file which will let you perform various operations on the
file.    Since the context menu might move or delete the file, Wilbur checks after the 
command is done to see if the file is still there.    If it isnt then the file is removed from the 
index.    This also provides a handy shortcut for removing index entries for files that have 
been removed in other ways.



File Contents Pane
At the bottom of Wilburs window is the file contents pane which displays the text of the file 
selected in the file list. 

The purpose of this display is just to show the sought after words in context.    No attempt is 
made to retain the formatting of word processing or other formatted files, but unprintable 
characters are stripped out and some basic paragraph and line formatting is done when 
possible.    Still some files such as MS Word documents may show a considerable amount of 
normally hidden material and may even have multiple copies of the desired text.    To view 
these files in their native format, simply double click the file name in the file list or select 
File/Launch to launch its associated application.    If you are running Windows 95, you may be
able to Quick View the file by bringing up the context menu with a right mouse click on the 
file name.

You cannot edit the material in the view pane, but you can select text by dragging the 
mouse cursor across it while holding the left mouse button down. The selected text can be 
copied it to the Windows clipboard with the Edit/Copy command.

When you click in the with mouse in the contents pane, it becomes the focus for keyboard 
commands. This is shown by displaying a text cursor and by switching the text from gray to 
black.    The arrow keys can then be used to scroll the contents up and down and sideways.    
The home and end keys can be used to jump to the top and bottom of the file respectively, 
while the page up and page down keys can be used to jump up and down one screen at a 
time.

While the contents pane has the focus you can also start a secondary search by simply 
starting to type a search phrase.    A search dialog is opened where you can complete the 
search phrase.    When this dialog is closed, Wilbur will start searching from the current 
cursor position for the word or words.    The Search/Find Next or the Search/Find Previous 
command can be used to continue the search for further occurrences.    When the end of file 
(or beginning if reverse searching) is found, the search continues in the next file in the list.    
Note that succeeding files are only searched when the Search/Find Next or the Search/Find 
Previous command is used.    If the original search did not find the string, it will not 
automatically proceed to the next file unless one of those commands is used.

To stop a search that is proceeding through successive files without success, click in either 
the file list or the file contents pane or press any key on the keyboard.



Command Line Arguments
If Wilbur finds a file name on its command line when it starts up, it will automatically open 
that file as an index.    This is standard behavior for Windows programs and is necessary so 
that double clicking on an index works correctly.
You can also follow the file name with a space and a search phrase.    Wilbur will then start 
and automatically bring up the search dialog with that phrase filled in.    This makes it easy 
to construct a simple word processor macro which will automatically launch Wilbur and 
search for the word under the cursor when an assigned hot key is pressed. (MS Word 
Example)
A similar procedure can be used in a programming development environment to search 
sample files etc.
The command line can also be used to automatically build or update an index.    If Wilbur 
finds a -b on the command line before the file name, it will automatically rebuild the index 
after it opens it and then save the new index and shutdown. This allows you to use the 
System Agent in the Windows 95 Plus pack or the NT AT command can be used to launch 
Wilbur at a predetermined time like the middle of the night, and rebuild its index.    It could 
also be used if you want to use an icon to launch a build.
A -u is treated similarly, but starts an update instead of a build.

If a copy of Wilbur is already running when you try to run a second copy, Wilbur simply 
switches to the original copy and attempts to execute the new command line, if there is one.
By placing a -2 switch as the first parameter on the command line, you can override this 
behavior and have a second copy of Wilbur open.    Also a copy of Wilbur opened with the -2 
parameter will not be usurped by another run of Wilbur even if that second call does not 
have the -2 parameter on the command line.



Word Macro Example

The following macro, suitably modified for your path names, can be used to launch Wilbur 
and search for the text under the cursor:

Sub MAIN
SelectCurWord
Shell "g:\wilbur\WinRel\wilbur.exe " + "d:\wilbur\text.wilbur " + Selection$()
SendKeys "{enter}"

End Sub

or if you have spaces in your path names you will need the more complicated form:

Sub MAIN
SelectCurWord
Shell Chr$(34) + "g:\wilbur\WinRel\wilbur.exe" + Chr$(34) + " " + "'d:\wilbur\

text.wilbur' " + Selection$()
SendKeys "{enter}"

End Sub

Please be careful to get the spaces after the path names included correctly.

Use the Tools/Macro command to create the macro and give it a name like Wilbur.    Then use
the Tools/Customize command to assign a hot key (Ctrl+Alt+W perhaps) to the macro and 
you are in business.



View International Characters
This command can be used to toggle the display of international characters in the contents 
pane.    When the toggle is on, there will be a check mark beside the command in menu and 
characters such as those with diacritic marks like ç, ü, æ, å etc. will be displayed in the 
contents page.    Normally this switch is automatically set by the state of the international 
character check box used in the index dialog box when the index was created. Changing this
toggle has no effect on whether words with international characters are indexed.



View Next File

Selects the next file in the file list and displays its contents in the contents pane.

Shortcuts
Keys: CTRL+PgDn



View Next File

Selects the previous file in the file list and displays its contents in the contents pane.

Shortcuts
Keys: CTRL+PgUp



View - Quickview
Launches Quickview for the currently selected file.
Shortcuts

Keys: CTRL+Q
Right click any where in the contents pane.



View - Automatic Quickview
When this option is on, Wilbur launches Quickview every time a new file is selected and then
waits a second before once again making itself the active window.    The effect is to keep the 
Quickview window synchronized with the Wilbur selection.    You will want to size the 
Quickview window and the Wilbur window appropriately so that both can be seen and be 
sure and tell Quickview to reuse its window so that you dont end up with a horde of 
Quickview windows.
Shortcuts

Keys: CTRL+A




